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Note The Application Examples are not binding and do not claim to be complete 
regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to pro-vide support for typical applications. You are responsible in ensuring that 
the de-scribed products are correctly used. These Application Examples do not 
relieve you of the responsibility in safely and professionally using, installing, 
operating and servicing equipment. When using these Application Examples, you 
recognize that Siemens cannot be made liable for any damage/claims beyond 
the liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice. If there are any deviations 
between the recommendations provided in these Application Examples and 
other Siemens publications - e.g. Catalogs - then the contents of the other 
documents have priority. 
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Warranty, liability and support 
 
We do not accept any liability for the information contained in this document. 
Any claims against us - based on whatever legal reason - resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Examples shall be excluded. Such an exclusion shall 
not apply in the case of  mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). However, claims arising from a breach of a 
condition which goes to the root of the contract shall be limited to the foreseeable 
damage which is intrinsic to the contract, unless caused by intent or gross 
negligence or based on mandatory liability for injury of life, body or health The 
above provisions does not imply a change in the burden of proof to your detriment. 
Copyright© 2009 Siemens A&D. It is not permissible to transfer or copy these 
Application Examples or excerpts of them without first having prior 
authorization from Siemens A&D in writing. 
If you have any recommendations relating to this document then please send them 
to us at the following e-mail address: 
mailto:sdsupport.aud@siemens.com 
 

mailto:sdsupport.aud@siemens.com�
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Preposition 
Aim of the application 

This application has been created to show users how to control MICROMASTER 4 
(MM4) and SINAMICS G120/G120D frequency inverters via PROFIBUS DP and 
PROFINET using a SIMATIC HMI station. 
This application shows how, using an HMI panel, frequency inverter parameters 
can be displayed and changed. 

Scope 
The following core issues are discussed in this application: 
• Example for controlling a frequency inverter using an HMI panel via 

PROFIBUS DP 
• Example for controlling a frequency inverter using an HMI panel via 

PROFINET 

Exclusion 
This application does not include any description of the following 
• The SIMATIC STEP 7 programming tool 
• The WinCC Flexible programming tool 
• The basic commissioning of the frequency inverter 
It is assumed that readers have basic knowledge about these two subjects. 
 
Due to differences in the parameter structure, this application cannot be used for 
SINAMICS CU230. 
 

Reference to the Automation and Drives Service & Support 
This article is from the Internet Application Portal of the Automation and Drives 
Service & Support. You can go directly to the download page of this document 
using this link. 
http://support.automation.siemens.com/WW/view/en/22072988  
 
 

http://support.automation.siemens.com/WW/view/en/22072988�
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Application description 
This application shows how a MICROMASTER 4 (MM4) and a SINAMICS 
G120/G120D frequency inverter can be controlled from an HMI station.  
Two examples for controlling the frequency inverter using an HMI station are 
described in this application: 
- controlling two frequency inverters - a MICROMASTER 440 frequency inverter 

and a SINAMICS G120 frequency inverter - with CU240S DP-F - via 
PROFIBUS; 

- controlling two SINAMICS G120 frequency inverters equipped with CU240S 
PN (Control Unit) via PROFINET. 

 

1 Task 
In "Normal operation" the control commands and setpoints are transferred, using 
cyclic telegrams, from the SIMATIC control system via PROFIBUS-DP in the first 
example and via PROFINET in the second example. 
In a so-called "Emergency mode" – when the cyclic PROFIBUS-DP/PROFINET is 
faulted, a drive operation is still to be guaranteed. For example, this situation can 
occur when commissioning the plant/system and the CPU goes into Stop.  
The control (open-loop) and setpoint input should, in an "Emergency mode" be 
realized from a SIMATIC HMI station. This can mean, for example, from an 
Operator Panel (OP) or a Touch Panel (TP). In this case, it is necessary to use a 
SIMATIC OP or TP where the last digit is a 7. The reason for this is that these can 
directly access the drive as PROFIBUS master, Class 2 (non-cyclic services 
[utilities]). However, it should be noted that only parameter values can be accessed 
(comparable to the PKW part of the cyclic telegram) and not the cyclic PZD data - 
e.g. control word 1. This involves non-cyclic services [utilities]. This means that 
these are completely independent of the selected cyclic telegram types (PP0 or 
Siemens telegrams). 
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2 Components required 
Here you'll find an overview of the hardware and software components required for 
the function example. 

2.1 Hardware components 

 

Controlling via PROFIBUS-DP: 
 

Table 2-1 Hardware components for the HMI control via PROFIBUS-DP 

Component Type Order No. 
[MLFB]/ordering data No. Manufacturer 

S7 Control 

Power supply PS307 5A 6ES7307-1EA00-0AA0 1 

S7-F CPU  CPU 317F-2 PN/DP 6ES7317-2FK13-0AB0 1 

Memory Card MMC 8 MB 6ES7953-8LP11-0AA0 1 

SIEMENS 

Drive 

SINAMICS G120 Control Unit  CU240S DP-F 6SL3244-0BA21-1PA0 1 

SINAMICS G120 Power Module  PM240 6SL3224-0BE13-7UA0 1 

MICROMASTER 440 MICROMASTER 440 6SE6440-2AB11-2AA1 1 

PROFIBUS Module MICROMASTER 4 
PROFIBUS module 6SE6400-1PB00-0AA0 1 

PROFIBUS Cable 10m 

SIMATIC NET, PB FC 
Standard Cable GP, 2-wire, 
shielded, min. ordering 
quantity: 20 m sold by the 
meter 

6XV1830-0EH10 1 

PB connector 
PB FC RS 485 PLUG 180, 
PB connector w. fast connect 
connector 

6GK1500-0FC00 4 

PB connector 

SIMATIC DP, bus connector 
for PROFIBUS up to 12 
Mbit/s with tilted outgoing 
cable 

6ES7972-0BA41-0XA0 2 

Motor Asynchronous motor 1LA7060-4AB10 2 

Motor cable, 3m Motor cable 6ES7194-1LA01-0AA0 1 

SIEMENS 

Line supply feeder cable Line supply feeder cable - 1 - 
HMI Device 

HMI Device TP177B PN/DP SIMATIC TP 177B Touch 
Panel w. 5,7” STN-Display, 
PN/DP: Color (256 colours) 

6AV6 642-0BA01-1AX0 1 SIEMENS 

PG/PC 

PG/PC SIMATIC Field PG M 6ES7712-1BB10-0AG2 1 SIEMENS 
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Controlling via PROFINET: 
 

Table 2-2 Hardware components for the HMI control via PROFINET 

Component Type Order No. 
[MLFB]/ordering data No. Manufacturer 

S7 Control 

Power supply PS307 5A 6ES7307-1EA00-0AA0 1 

S7-F CPU  CPU 317F-2 PN/DP 6ES7317-2FK13-0AB0 1 

Memory Card MMC 8 MB 6ES7953-8LP11-0AA0 1 

Ethernet Switch Scalance X206-1 6GK5206-1BB10-2AA3 1 

SIEMENS 

Drive 

SINAMICS G120 Control Unit  CU240S PN 6SL3244-0BA20-1FA0 2 

SINAMICS G120 Power Module  PM240 6SL3224-0BE13-7UA0 2 

Ethernet Cable 10m 
PROFINET Cable, min. 
ordering quantity: 20 m sold 
by the meter 

6XV1870-2B 1 

Connector RJ45 PLUG 180 RJ45 6GK1901-1BB10-2AA0 9 

Connector RJ45 PLUG 145 RJ45 6GK1901-1BB30-0AA0 1 

Motor Asynchronous motor 1LA7060-4AB10 2 

Motor cable, 3m Motor cable 6ES7194-1LA01-0AA0 1 

SIEMENS 

Line supply feeder cable Line supply feeder cable - 1 - 
HMI Device 

HMI Device TP177B PN/DP SIMATIC TP 177B Touch 
Panel w. 5,7” STN-Display, 
PN/DP: Color (256 colors) 

6AV6 642-0BA01-1AX0 1 SIEMENS 

TCP/IP network 

Network adapter USB/PCMCIA LAN Adapter - 1 - 

PG/PC 

PG/PC SIMATIC Field PG M 6ES7712-1BB10-0AG2 1 SIEMENS 

 

Note: 
The functionality was tested using the specified hardware components. Similar 
products can be used that however deviate from the list above. In such a case 
please be aware that possible changes may be required to the code used for this 
example (e.g. other addresses may have to be set). 
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2.2 Software components 
Table 2-3 Software components 

Component Type Order No. 
[MLFB]/ordering data No. Manufactur

er 

SIMATIC STEP 7 V5.4 + SP2 6ES7810-4CC08-0YA5 1 

STARTER V4.1 + SP1 6SL3072-0AA00-0AG0 
oder Downloads 

1 

WinCC Flexible Compact WinCC Flexible 2007 Compact 
Engineering-SW, Floating License 
License key on USB stick 

6AV6611-0AA51-2CA5 1 

PROFIBUS GSD file PROFIBUS file for SINAMICS G120 
FW 3.0 

Downloads 1 

PROFINET GSDML file PROFINET file for SINAMICS G120 
FW 3.0 

Downloads 1 

PROFIBUS GSD file PROFIBUS file for MICROMASTER 
4 

Downloads 1 

SIEMENS 

 

http://support.automation.siemens.com/WW/view/en/26233208�
http://support.automation.siemens.com/WW/view/en/23450835�
http://support.automation.siemens.com/WW/view/en/26641490�
http://support.automation.siemens.com/WW/view/en/6567719�
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3 PROFIBUS-DP control  
3.1 Structure of the PROFIBUS net 

Connect all of the PROFIBUS devices as shown in Fig. 3-1. 
 

 
Figure 3-1 Control via PROFIBUS DP 

 

3.2 Implementing the function 

The main philosophy to implement the requested function is as follows:  
1. Two command data sets (CDS) are parameterized in all of the frequency 

inverters:  
– command data set CDS01 for "Normal operation" (control and setpoint 

sources via fieldbus: P0700[0] = 6, P1000[0] = 6); 
– command data set CDS12 for "Emergency operation" (control source via 

terminals (P0700[1] = 2) and setpoint source via a fixed frequency 
(P1000[1] = 3)). 

                                                      
1 CDS0 bei CU240, CDS1 bei MM4 
2 CDS1 bei CU240, CDS2 bei MM4 
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2. Using the HMI station, parameter P0810 (BI: CDS bit0 (manual/automatic)) is 
changed from 0 to 1 and therefore a changeover is made between the control 
and setpoint sources for the two operating modes ("Standard operation" and 
"Emergency operation").  
A changeover is made between two command data sets [these are toggled 
between] which means that the BICO interconnections are kept. As a 
consequence, all of the parameter settings can be permanently parameterized 
in the frequency inverter for the "Emergency operation" mode.  

3. In "Emergency operation", using the HMI station, parameter P0731[1] (BI: 
Function of digital output DO01) is changed from 0 to 1; this means that digital 
output DO01 is set.  
The frequency inverter can be powered-up by interconnecting the state of 
digital output DO01 r0747.0 with parameter P0840[1].  
The frequency inverter is powered-down by writing a value of "0" into 
parameter P0731[1]. 

4. For "Emergency operation" the setpoint is defined e.g. by the fixed frequency 1 
(P1001[0]). In this case fixed frequency 1 is selected as steady-state 
(statically). To do this, parameter P1020[1] (BI: Fixed frequency selection, bit 
0) is set to 1. The value of fixed frequency 1 can be changed via the HMI 
station. 

                                                      
1 Digital output 0 (DO0) for CU240, digital output 1 (DO1) for MM4 
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3.3 Parameterization of the drives 

Parameterize the frequency inverter. The parameterization is as follows: 
 

Parameterization of the MICROMASTER 440: 
 
Table 3-1 Parameterization of the MICROMASTER 440 

Parameter 
No. 

Designation Parameter value Note / comments 

P0700[0] Selection of command source, CDS1 6 6: PROFIBUS  
P0700[1] Selection of command source, CDS2 2 2: Terminals  
P0701[1] Function of digital input 1 (DI1), CDS2 99 99: Enable BICO 

parameterization 
P0840[1] BI: ON/OFF1, CDS2 r0747.0 Enable ON/OFF1 = 

Digital output 1 
P1000[0] Selection of frequency setpoint, CDS1 6 6: PROFIBUS 
P1000[1] Selection of frequency setpoint, CDS2 3 3: Fixed frequency 
P1020[1] BI: Fixed freq. selection Bit 0, CDS2 1 Fixed frequency 1 

selected as steady-state 
(statically) 

P2040 Fieldbus telegram off time 0 0: Watchdog disabled 
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Parameterization of the CU240S DP-F: 
 
Table 3-2 Parameterization of the CU240S DP-F 

Parameter 
No. 

Designation Parameter value Note / comments 

P0700[0] Selection of command source, CDS0 6 6: PROFIBUS  
P0700[1] Selection of command source, CDS1 2 2: Terminals  
P0701[1] Function of digital input 0 (DI0), CDS1 99 99: Enable BICO 

parameterization 
P0704[1] Function of digital input 3 (DI3), CDS1 99 99: Enable BICO 

parameterization 
P0840[1] BI: ON/OFF1, CDS2 r0747.0 Enable ON/OFF1 = 

Digital output 1 
P1000[0] Selection of frequency setpoint, CDS1 6 6: PROFIBUS 
P1000[1] Selection of frequency setpoint, CDS2 3 3: Fixed frequency 
P1020[1] BI: Fixed freq. selection Bit 0, CDS2 1 Fixed frequency 1 

selected as steady-state 
(statically) 

P2040 Fieldbus telegram off time 0 0: Watchdog disabled 
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3.4 Configuring in SIMATIC Manager 

Open the SIMATIC Manager and create a new project 
• Open the SIMATIC Manager and create a new project.  
• Insert a SIMATIC 300-Station in the project.  
 

Configuring HW-Config 
• Open HW-Config and carry-out the following configuring (refer to Fig. 3-2): 
 

 
Figure 3-2 Configuring HW-Config 

 

Configuring the SIMATIC station 
• Insert the rack RACK-300 for SIMATIC-300, and 
• Set-up the SIMATIC station (power supply and CPU). 
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Creating the PROFIBUS subnet 
• Double click on the button "MPI/DP". 
• In the properties window, under "Type" select the PROFIBUS interface and 

press on the "Properties" button. 
• In the dialog box that is displayed, select a PROFIBUS address for the CPU 

(e.g. "2") and press the "New…" button. 
• In the next dialog box, in the "Network settings" directory, select the data 

transfer rate (e.g. 1.5 Mbit/s) and the "DP" profile of the PROFIBUS interface.  
• Acknowledge all of the entries that you made with "OK" and then close all of 

the property windows. 
 

Configuring the frequency inverter 

Prerequisite 
The PROFIBUS GSD files must have been installed in order that the 
MICROMASTER 4 and the Control Units CU240S/D DP/DP-F of the SINAMICS 
G120/G120D can be accessed via PROFIBUS: 
• PROFIBUS GSD file for MICROMASTER 4 
• PROFIBUS GSD file for SINAMICS G120 V3.0 
 

Installing the GSD files 
Install the PROFIBUS GSD files via the menu item "Options -> Install GSD 
File…" of HW-Config. 
 
After you have installed the PROFIBUS GSD files the corresponding files appear in 
the HW Catalog under the "Standard Profile" in the folders "PROFIBUS DP \ 
Additional Field Devices \ Drives \ SIMOVERT \ MICROMASTER 4" and 
"PROFIBUS DP \ Additional Field Devices \ Drives \ SINAMICS \ SINAMICS 
G120 CU240S DP F v3.00". 
 

http://support.automation.siemens.com/WW/view/en/6567719�
http://support.automation.siemens.com/WW/view/en/23450835�
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Proceed as follows: 
• Configure the MICROMASTER 440 frequency inverter with the GSD file from 

the directory "PROFIBUS DP \ Additional Field Devices \ Drives \ 
SIMOVERT \ MICROMASTER 4" of the HW Catalog (hardware Catalog).  

• Configure the SINAMICS G120 frequency inverter with CU240S DP-F (Control 
Unit) with the GSD file from the directory "PROFIBUS DP \ Additional Field 
Devices \ Drives \ SINAMICS \ SINAMICS G120 CU240S DP F v3.00" of the 
HW Catalog (hardware Catalog). 

• Configure PROFIBUS address 3 for MM440 and PROFIBUS address 4 for 
CU240S DP-F. 

• For the MM440 frequency inverter and for the CU240S DP-F Control Unit, 
configure the telegram type "Standard Telegram 1". 

• Save and compile your configuration and close the HW-Config. 
 

Configuring organization block OB1 
Open OB1 and make the following entries (refer to Fig. 3-3): 
 

 
Figure 3-3 Configuring organization block OB1 
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Generating the variable table 
Insert a variable table into the project, open it and make the following entries (refer 
to Fig. 3-4): 
 

 
Figure 3-4 Generating the variable table 

 

Set PG/PC interface 
Set the PG/PC interface by pressing on the button "Options -> Set PG/PC 
Interface…" in the menu of the SIMATIC Manager. 
Select your communications processor for the PROFIBUS interface from the list 
(e.g. CP5611(PROFIBUS)). 
 

Downloading the configured SIMATIC station into the CPU  
Download the configured SIMATIC station into the CPU by selecting the SIMATIC 

station in the project tree and then pressing on the "Download"  button. 
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Configuring the SIMATIC HMI station  
A SIMATIC HMI station is configured in the following using the software package 
SIMATIC WinCC Flexible Compact.  
It is possible to integrate an existing WinCC project into a STEP 7 project. To do 
this, the menu item of WinCC "Project -> Integrate in STEP 7…" is used. 
This means that you can create a project in WinCC to control the frequency 
inverter using an HMI. You can then subsequently integrate this control into the 
STEP 7 project. 
It is also possible to start configuring an HMI station from STEP 7. To do this, a 
SIMATIC HMI station must be inserted into the STEP 7 project.  
Proceed as follows: 
 

Inserting a SIMATIC HMI station  
Insert a SIMATIC HMI station into the project by pressing on the "Insert -> 
Station -> 5 SIMATIC HMI-Station" button in the SIMATIC Manager menu (refer 
to Fig. 3-5): 
 

 
Figure 3-5 Inserting a SIMATIC HMI station  
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Select HMI device 
In the dialog box that is displayed, select your operator control device (in our 
particular example, SIMATIC Touch Panel TP177B color PN/DP) and the version 
of this device (e.g. 1.1.0.0) and then close the window with "OK" (refer to Fig. 3-6). 
 

 
Figure 3-6 Selecting an HMI device 

 

Result: The "SIMATIC HMI-Station(1)" directory is displayed in the project tree. 
 

 
Figure 3-7 SIMATIC HMI station in the project tree 
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3.5 Configuring in WinCC Flexible Compact 

Start WinCC Flexible Compact  
WinCC Flexible Compact must be started.  
To do this, for example, in the SIMATIC Manager in the project tree select 
"SIMATIC HMI-Station(1) -> WinCC Flexible RT -> Communication -> 
Connections" - and then double click on the "Connections" button (refer to Fig. 
3-8). 
 

 
Figure 3-8 WinCC Flexible Compact - opening the "Connections" dialog box 

 
Result:  

SIMATIC WinCC Flexible Compact is started with the "Connections" Editor 
open (refer to Fig. 3-9). 
 

Double click 
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Creating a new connection 

 
Figure 3-9 Creating a new connection 

 
Create a new connection (data link) for the communications between the HMI 
panel and the frequency inverter.  
Proceed as follows (refer to Figs. 3-9 and 3-10):  
• Select the first cell "Name" from the first line in the "Connections" Editor. The 

"Connection_1" name then appears. When required, you can also change the 
names. 

• Activate the connection (data link) by selecting "On" in the cell "Active". 
• As communication driver select "SIMATIC S7 300/400". 
• In the "Online" cell, select "On". 
 

 
 
Figure 3-10 Creating a new connection 

 

Making the settings for the configured connection 
Make the following settings for the configured connection (refer to Fig. 3-11): 
• In the pull down menu "Interface" select "IF1 B". 
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• Make the following settings in the lefthand section "HMI device" of the 
window: 
– Set the Baud rate (e.g. set this to 1500000). 
– Select the PROFIBUS address of the HMI station (e.g. "1"). 
– As access point select S7ONLINE. 
– With the checkmark select "Only master on the bus". 

 

 
Figure 3-11 Making the settings for the configured connection 

 
• In "Network" - in the center of the window - under "Profile" select "DP". 
• In "PLC device" – in the righthand part of the window:  

– Set the PROFIBUS address of one of the two frequency converters (e.g. 
the PROFIBUS address of the MM440 frequency inverter = "3"). 

– Remove the checkmark - "Cyclic operation". 
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Open the "Tags" Editor 
Open the "Tags" Editor: In the project tree, select "SIMATIC HMI-Station(1) -> 
Communication -> Tags" and double click on the button "Tags" (refer to Fig. 3-
12). 
 

 
Figure 3-12 Opening the „Tags“ Editor 

 

 
Figure 3-13 Editor „Tags“ 
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Setting-up and configuring variables 
In our particular example, three variables must be set-up and configured to access 
drive parameters: 
• Variable P0731 to change parameter P0731[1] (drive ON/OFF) 
• Variable P0810 to change parameter P0810 (operating mode: "Standard 

operation" / "EMERGENCY OPERATION") 
• Variable P1001 to change parameter P1001[0] (setpoint input in "Emergency 

Operation") 
 

The following simple rule applies when accessing drive parameters: 
 

• parameter number = data block number 
• parameter sub-index = data block offset  
  
Make the following entries into the variable editor (refer to Table 3-3 and Fig. 3-14): 
 

Table 3-3 Setting-up and configuring variables 

Name Connection Data type Symbol Address Array 
count 

Acquisition 
cycle 

P0731 Connection_1 DWord <Undefined> DB731 DBD1 1 1s 
P0810 Connection_1 DWord <Undefined> DB810 DBD0 1 1s 
P1001 Connection_1 Real <Undefined> DB1001 DBD0 1 1s 

 

 
Figure 3-14 Setting-up and configuring variables 
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Note: 
The data types of the variables depend on the addressed parameter values. 
Generally, the following matches apply to data types: 
 
Table 3-4 Parameter data types and variable data types 

Parameter data type Significance Variable data type 

Unsigned8 (U8) 8-bit unsigned Byte 
Unsigned16 (U16) 16-bit unsigned Word, Int 
Unsigned32 (U32) 32-bit unsigned DWord, DInt 
Integer16 (I16) 16-bit integer Int, Word 
Integer32 (I32) 32-bit integer DInt, DWord 
Floating Point (Float) Floating point Real 

 

Note: 
Please take the parameter data types from the parameter lists associated with the 
corresponding frequency inverters. 
 

Note: 
Also read Section 6.5 "SIMATIC HMI (Human-Machine Interface)" of the Operating 
Instructions MICROMASTER PROFIBUS Optional board. 

 

http://support.automation.siemens.com/WW/view/en/6586565�
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Open the "Text Lists" Editor 
Open the "Text Lists" Editor: And in the project tree select "SIMATIC HMI-
Station(1) -> Text- and Graphics Lists -> Text lists" and then double click on the 
button "Text Lists" (refer to Fig. 3-15). 
 

 
Figure 3-15 Opening the „Text Lists“ Editor 

 

 
Figure 3-16 Editor „Text Lists“ 
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Setting-up and configuring text lists 
One text list must still be set-up for each of the variables P0731 and P0810.  
In our particular example, frequency inverter parameters P0731 and P0810 must 
be changed from 0 to 1 and vice versa using variables P0731[1] and P0810. This is 
the reason that two list entries must be configured for each of the text lists that 
have been set up: One for the value 0 and one for the value 1 (refer to Figs. 3-17 
and 3-18). 
 

Note: 
Please note that the frequency inverter parameters P0731[1] and P0810 
correspond to the value 1 and variables P0731 and P0810 correspond to the value 
65536. 
 
Set-up the following text lists:  
 
Table 3-5 Setting-up text lists 

Name Selection 

P0731 Range (…-…) 
P0810 Range (…-…) 

 
 
Configure the following list entries for the text lists that have been set-up:  
 
Table 3-6 Configuring list entries 

Text list Value Entry 

0 0: OFF P0731 
65536 1: ON 
0 0: Normal Operation P0810 
65536 1: Emergency Operation 
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Figure 3-17 Entries for variable P0731 

 

 
Figure 3-18 Entries for variable P0810 
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Open the "Screens" Editor 
Open the "Screens" Editor: In the project tree select "SIMATIC HMI-Station(1) -> 
Screens -> Screen_1" and then double click on the "Screen_1" button (refer to 
Fig. 3-19). 
 

 
Figure 3-19 Opening the „Screens“ Editor 

 

 
Figure 3-20 Editor „Screens“ 
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Setting-up and configuring buttons to changeover (toggle) between slaves 
Set-up the two buttons to changeover (toggle) between slaves. Drag this from the 
tool window and drop it in the window for the HMI display (refer to Fig. 3-21).  
 

 
Figure 3-21 Setting-up and configuring buttons for the changeover 

 
Configure the buttons as follows: 
• In the properties window, select the "General" tab 
• As type, select the "Text" button 
• Enter a matching text for each button (e.g. "Slave 3" and "Slave 4") 
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The buttons must now be assigned to a function that can be used to changeover 
(toggle) between slaves.  
The "ChangeConnection" function can be used for this purpose. It interrupts the 
connection to the control that is being used (in our particular case, the frequency 
inverter) and establishes a new connection to the specified control (frequency 
inverter). 
Proceed as follows (refer to Figs 3-22 and 3-23): 
• Select one of the buttons. 
• In the properties window, change to the "Events" tab. 
• Select the "Click" sub-tab. 
• Insert the "ChangeConnection" function into the first line of the function list: 

Select this in the pull down menu under "System functions -> Settings -> 
ChangeConnection". 

• Set the connection to "Connection_1". 
• Set the PROFIBUS address to 3 (MM440). 
• Enter a "0" as slot and subrack. 
• Use the same settings for the second button - with the exception of the 

PROFIBUS address. Set this (the PROFIBUS address) to 4 (CU240S DP-F). 

 
Figure 3-22 Setting-up the ChangeConnection function for button 1 (slave 3) 

 

 
Figure 3-23 Setting-up the ChangeConnection function for button 2 (slave 4) 
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Setting-up and configuring input/output fields for the variables 

Set-up two symbolic I/O fields for the variables P0810 or P0731 and an I/O field for 
the variable P1001 (refer to Fig. 3-24). 
 

 
Figure 3-24 Setting-up and configuring input / output fields for the variables 
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Configure the I/O field for variable P0810 as follows (refer to Fig. 3-25): 
• In the "General" tab, as mode, select "Input/Output" ("Settings" block). 
• Select P0810 as Tag ("Process" block). 
• Select P0810 as Text list ("Display" block). 
 

 
Figure 3-25 Configuring the I/O field for the variable P0810  

 
 
Configure the I/O field for variable P0731 as follows (refer to Fig. 3-26): 
• In the tab "General" as Mode, select "Input/Output" ("Settings" block). 
• As Tag, select P0731 ("Process" block). 
• As Text list, select P0731 ("Display" block). 
 

 
Figure 3-26 Configuring the I/O field for the variable P0731  
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Configure the I/O field for variable P1001 as follows (refer to Fig. 3-27): 
• In the tab "General" as Mode, select "Input/Output" ("Settings" block). 
• As Tag, select P1001 ("Process" block). 
• As Format type, select Decimal and as Format pattern, 99,99 ("Display" 

block). 
 

 
Figure 3-27 Configuring the I/O field for variable P1001 
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Setting-up and configuring the button to exit the project presently running 
A button can be set-up and configured to exit the project that is presently running; 
however, this button isn't absolutely necessary. 
Sets-up a new button (refer to Fig. 3-28).  
 

 
Figure 3-28 Setting-up a button to exit the project presently running 
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Configure the button as follows (refer to Fig. 3-29): 
• In the properties window, select the tab "General". 
• As type, select the "Text" button. 
• Enter an appropriate text for this button (e.g. "Exit"). 
• Go to the "Events" tab in the properties window. 
• Select the "Click" sub-tab. 
• Insert the "StopRuntime" function in the first line of the function list: Select 

this in the pull down menu under "System functions -> Other functions -> 
StopRuntime". 

 

 
Figure 3-29 Configuring a button to exit the project presently running 

 

Saving a WinCC project 
You can now save the project. In the WinCC menu, select "Project -> Save" or 
press on the "Save current project"  button in the menu bar. 
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3.6 PROFIBUS DP settings of the HMI device 

Switch on the power supply for the HMI device. The Loader opens once the 
operating system has started (refer to Fig. 3-30). 
 

  
Figure 3-30 Loader 

 
Press "Control Panel" to open the HMI device Control Panel (refer to Fig. 3-30). 
 

Open the "Transfer Settings" dialog with the "Transfer"  icon (refer to 
Fig. 3-31). 
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Proceed as follows (refer to Fig. 3-31): 
• Activate the respective data channel with the "Enable Channel" check box in 

the "Channel 1" or "Channel 2" group (in the example „Channel 2“). 
• Configure the automatic transfer for the data channel 2. 

Check the "Remote Control" check box to turn on the automatic transfer. 
• As protocol, enter "MPI/Profibus" for "Channel 2". 

Touch the selection field. A selection list is displayed. 
 

 
Figure 3-31 „Transfer Settings“ dialog 

 
• Press the "Advanced" button (refer to Fig. 3-31). 
 

 
Figure 3-32  „S7-Transfer Settings“ dialog 

 
• Select the PROFIBUS network and press the "Properties…" button (refer to 

Fig. 3-32).  
 

The following dialog is displayed (refer to Fig. 3-33). Proceed as follows: 
• Activate the check box "Panel is the only master on the bus". 
• Enter the bus address for the HMI device in the "Address" input field (in the 

example „1“). 
Touch the input field. The symbolic screen keyboard is displayed. 

• Enter a Baud Rate for the HMI device in the "Transmission Rate" input field 
(in the example 1.5 Mbit/s). 
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Touch the selection field. A selection list is displayed. 
• Select the highest station address on the bus in the "Highest Station 

Address" field (in the example, the factory setting "31" is kept).  
Touch the selection field. A selection list is displayed. 

• Select the profile “DP” from the "Profile" selection field.   
Touch the selection field. A selection list is displayed. 

 

 
Figure 3-33 PROFIBUS settings 

 

• Close the dialogs „PROFIBUS“, „PROFIBUS“, S7-Transfer Settings“ and 
„Transfer Settings“ with  to save your entries. 
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Result: 
The PROFIBUS DP settings of the HMI device have been changed. 
 

Close the Control Panel of the HMI device with . The loader is displayed. Press 
the "Transfer" button to start the "Transfer" operating mode (refer to Fig. 3-34). 
 

 
Figure 3-34 Starting the transfer operation at the operator unit 

 
The transfer operation must now be started from WinCC. 
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3.7 Transfer project in the HMI device 

In the WinCC menu, select "Project -> Transfer -> Transfer Settings…" (refer to 
Fig. 3-35). 
 

 
Figure 3-35 Transferring project in the HMI device 
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The following window opens - "Select devices for transfer". Here, as Mode, 
select "MPI/DP" and set the station address (the PROFIBUS address of the 
operator control device, in this particular example "1"). Then press the "Transfer" 
button (refer to Fig. 3-36). 
 

 
Figure 3-36 Selecting devices for transfer 

 
The message - "Do you want to overwrite the existing password list on the 
device?" please acknowledge this with "Yes" (refer to Fig. 3-37). 
 

 
Figure 3-37 Overwriting the existing password list on the device 

 

Result:  
The transfer operation is started. After the project has been successfully 
transferred into the operator control device, the project is started at the operator 
control device. 
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3.8  Controlling the drives 

Normal Operation: Control from the S7 control 
In "Normal Operation", the drive inverters are controlled from the S7 control (S7 
PLC). The control commands and setpoints are sent to the drives through the 
variable table (refer to Fig. 3-38). 
The drive is started by sending the typical control word 047E, followed by 047F 
(edge of bit 0: ON). Word 047E should be sent to the drive to stop it (edge of bit 0: 
OFF).  
The frequency setpoint and actual value are normalized so that 4000(hex) 
corresponds to 50Hz. The highest value that should be sent is 7FFF. The 
normalization frequency (reference frequency) can be changed in P2000 (default 
50Hz).  
 

 
Figure 3-38 Controlling the drive inverter from the S7 control 
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Emergency Operation: Controlling the frequency inverter from the HMI operator control 
device 

In "Emergency Operation" the frequency inverters are controlled from the HMI 
operator control device.  
It is possible to change between (toggle) the two slaves (frequency inverter) and 
control these. 
 
Proceed as follows (refer to Fig. 3-39): 
• Select one of the two inverters (slave 3 or slave 4). 
• Change to "Emergency Operation": In the pull down menu for parameter 

P0810 select "1: Emergency Operation". 
• Enter a setpoint into the frequency inverter by pressing the I/O field for the 

P1001. The numerical keypad is displayed. 
• Power-up the drive inverter by selecting "1: ON" in the pull down menu for 

P0731.1. 
• Power-down the frequency inverter by selecting "0: OFF" in the pull down 

menu for P0731.1. 
• The project presently running can be terminated/ended by pressing the "Exit" 

button. 
 

 
Figure 3-39 Controlling the frequency inverter from the HMI operator control device 
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4 PROFINET control  
4.1 Structure of the PROFINET 

Connect all of the PROFINET devices as shown in Fig. 4-1. 
 

Note: 
The following restrictions apply to the PROFINET connection of the HMI device: 
The HMI device should not be connected without a switch or a comparable device 
to a public Ethernet network. 
In this particular example, a Scalance X206-1 is used as switch.  
 

Note: 
You require a TCP/IP network adapter in order to be able to connect your PG/PC 
to PROFINET. 
 
 

 
Figure 4-1 Control via PROFINET 

 

4.2 Implementing the function 

Refer to Chapter 3.2. 
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4.3 Parameterization of the drives 

Parameterize the CU240S PN Control Units as follows: 
 

Parameterization of the CU240S PN: 
 
Table 4-1 Parameterization of the CU240S PN 

Parameter 
No. 

Designation Parameter value Note / comments 

P0700[0] Selection of command source, CDS0 6 6: PROFIBUS  
P0700[1] Selection of command source, CDS1 2 2: Terminals  
P0701[1] Function of digital input 0 (DI0), CDS1 99 99: Enable BICO 

parameterization 
P0704[1] Function of digital input 3 (DI3), CDS1 99 99: Enable BICO 

parameterization 
P0840[1] BI: ON/OFF1, CDS2 r0747.0 Enable ON/OFF1 = 

Digital output 1 
P1000[0] Selection of frequency setpoint, CDS1 6 6: PROFIBUS 
P1000[1] Selection of frequency setpoint, CDS2 3 3: Fixed frequency 
P1020[1] BI: Fixed freq. selection Bit 0, CDS2 1 Fixed frequency 1 

statically selected 
P8840 Fieldbus telegram off time 0 0: Watchdog disabled 
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4.4 Configuring in SIMATIC Manager 

Set PG/PC interface 
Open the SIMATIC Manager and create a new project. 
Set the PG/PC interface by pressing on the button "Options -> Set PG/PC 
Interface…" in the menu of the SIMATIC Manager. 
Select your network adapter for the TCP/IP network from the list. 
 

Note 
It is very important that in this case you select TCP/IP (Auto)! 
 

Editing Ethernet Node 
As a next step, you must enter the IP addresses as well as the PROFINET device 
names of all of the nodes (PLC, Control Units, Switch). These settings are made in 
the dialog box "Edit Ethernet Node". 
In the SIMATIC Manager menu, press on the button "PLC -> Edit Ethernet 
Node…". 
For more information please refer to the Application Article ID: 29157692 
"SINAMICS G: Reading from and writing to parameters of the Control Units 
CU240S/D PN/PN-F of the SINAMICS G120/G120D via PROFINET & PROFIBUS" 
(Section 2.3 "Editing Ethernet Node"). 
You can skip this chapter if you have already assigned IP addresses and 
PROFINET device names to the Ethernet Nodes, or if your devices already have 
these. 

http://support.automation.siemens.com/WW/view/en/29157692�
http://support.automation.siemens.com/WW/view/en/29157692�
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Configuring HW-Config 
• Insert a SIMATIC 300-Station in the project.  
• Open HW Config and make the following configurations (refer to Fig. 4-2): 
 

 
Figure 4-2 Configuring HW-Config 

 

Configuring the SIMATIC station 
• Insert the rack RACK-300 for SIMATIC-300, and 
• Set-up the SIMATIC station (power supply and CPU). 
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Creating the Ethernet subnet 
When you insert the CPU the window for the settings of the Ethernet interface 
opens. 
Proceed as follows: 
• Set the IP address for the CPU that you had assigned to it (192.168.0.1). 
• Enter "255.255.255.0" as subnet mask. 
• Select as gateway: "Do not use router". 
• Press the button "New…". 
• The "Properties – New subnet Industrial Ethernet" window opens. Here, 

you can assign a name to the subnet or leave the default setting.  
• Close the window with "OK". 
• In the previous window select the subnet that you created and close the 

window with "OK". 
For more information please refer to the Application Article ID: 29157692 
"SINAMICS G: Reading from and writing to parameters of the Control Units 
CU240S/D PN/PN-F of the SINAMICS G120/G120D via PROFINET & 
PROFIBUS" (Section 3.2 "Creating the Ethernet subnet"). 

 

Configuring frequency inverters 

Prerequisite 
PROFINET GSDML files for SINAMICS G120 V3.0 must have been installed in 
order that the Control Unit CU240S PN can be accessed via PROFINET. 
 

Installing the GSDML file 
Install the PROFINET GSDML file via the menu item "Options -> Install GSD 
File…" of HW-Config. 
 
After you have installed the PROFINET GSDML file the corresponding files appear 
in the HW Catalog under the "Standard Profile" in the folder "PROFINET IO > 
Drives > SINAMICS > GSD". 

http://support.automation.siemens.com/WW/view/en/29157692�
http://support.automation.siemens.com/WW/view/en/29157692�
http://support.automation.siemens.com/WW/view/en/29157692�
http://support.automation.siemens.com/WW/view/en/26641490�
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Proceed as follows: 
• Configure the SINAMICS G120 frequency inverter with CU240S PN using the 

GSD file from the directory "PROFINET IO \ Drives \ SINAMICS \ GSD \ 
SINAMICS G120 CU240S PN" of the hardware Catalog. 

• Assign the Control Unit the name that you allocated to them when editing the 
Ethernet nodes (e.g. Drive01 and Drive02). 

• Configure the PROFINET addresses for the CU240S PN Control Unit (e.g. 
192.168.0.35 and 192.168.0.36). 

• For the two CU240S PN control units, configure the "Standard Telegram 1" 
telegram type. 

• Save and compile your configuration and close the HW-Config. 
 
For more information please refer to the Application Article ID: 29157692 
"SINAMICS G: Reading from and writing to parameters of the Control Units 
CU240S/D PN/PN-F of the SINAMICS G120/G120D via PROFINET & PROFIBUS" 
(Section 3.3 "Configuring the frequency inverter"). 
 

Configuring organization block OB1 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.4 
"Configuring in the SIMATIC Manager"). 

Creating a variable table 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.4 
"Configuring in the SIMATIC Manager"). 

Downloading the configured SIMATIC station into the CPU  
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.4 
"Configuring in the SIMATIC Manager"). 

Configuring the SIMATIC HMI station 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.4 
"Configuring in the SIMATIC Manager"). 

Select HMI device 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.4 
"Configuring in the SIMATIC Manager"). 
 

http://support.automation.siemens.com/WW/view/en/29157692�
http://support.automation.siemens.com/WW/view/en/29157692�
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4.5 Configuring in WinCC Flexible Compact 

Starting WinCC Flexible Compact 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact"). 
 

Creating a new connection 
Establish two new connections ("Connection_1" and "Connection_2") for 
communications between the HMI panel and the two frequency inverters (refer to 
Fig. 4-3).  
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact") for additional information. 
 

 
Figure 4-3 Creating new connections 
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Making the settings for the configured connections 
Make the following settings for the configured connections (refer to Fig. 4-4): 
• In the pull down menu "Interface" select "Ethernet". 
• Make the following settings in the lefthand section - "HMI device": 

– Select the PROFINET address of the HMI station (e.g. „192.168.0.45“). 
– Select S7ONLINE as access point. 

 

 
Fig. 4-4 Making the settings for the configured connections 

 
• In the righthand Section "PLC device" of the window:  

– Select the PROFINET addresses of the Control Unit (192.168.0.35 for the 
first frequency inverter, for "Connection_1" and 192.168.0.36 for the 
second frequency inverter for "Connection_2"). 

– Remove the checkmark "Cyclic operation". 
 
 

Open the "Tags" Editor  
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact"). 
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Setting-up and configuring variables 
In our particular example, three variables must be set-up and configured for each 
Control Unit; these three variables are to access drive parameters: 
• Variables P0731_1 and P0731_2 to change the parameter P0731[1] of the two 

Control Units (drive ON/OFF) 
• Variables P0810_1 and P0810_2 to change the parameter P0810 of the two 

Control Units (operating mode: "Normal operation" / "EMERGENCY 
OPERATION") 

• Variables P1001_1 and P1001_2 to change the parameter P1001[0] of the two 
Control Units (setpoint input in "Emergency Operation") 

 
Make the following entries in the variable Editor (refer to Table 4-2 and Fig. 4-5): 
 

Table 4-2 Setting-up and configuring variables 

Name Connection Data type Symbol Address Array 
count 

Acquisition 
cycle 

P0731_1 Connection_1 DWord <Undefined> DB731 DBD1 1 1s 
P0810_1 Connection_1 DWord <Undefined> DB810 DBD0 1 1s 
P1001_1 Connection_1 Real <Undefined> DB1001 DBD0 1 1s 
P0731_2 Connection_2 DWord <Undefined> DB731 DBD1 1 1s 
P0810_2 Connection_2 DWord <Undefined> DB810 DBD0 1 1s 
P1001_2 Connection_2 Real <Undefined> DB1001 DBD0 1 1s 

 

 
Figure 4-5 Setting-up and configuring variables 
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Also refer to the Section "Setting-up and configuring variables" of the 
PROFIBUS example (Chapter 3.5 "Configuring in WinCC Flexible Compact") 
for additional information. 
 

Opening the „Text Lists“ Editor  
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact"). 
 

Setting-up and configuring text lists 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact"). 
 

Opening the „Screens“ Editor 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact"). 
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Setting-up and configuring input/output fields for the variables 
Set-up four symbolic I/O fields for variables P0810_1, P0731_1, P0810_2 and 
P0731_2 and two I/O fields for variables P1001_1 and P1001_2 (refer to Fig. 4-6). 
 

 
Figure 4-6 Setting-up and configuring input/output fields for the variables 
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Configure the I/O field for variable P0810_1 as follows (refer to Fig. 4-7): 
• In the tab „General“ as Mode, select „Input/Output“ („Settings“ block). 
• As Tag, select P0810_1 („Process“ block). 
• As Text list, select P0810 („Display“ block). 
 

 
Figure 4-7 Configuring the I/O field for variable P0810_1 

 
 
Configure the I/O field for variable P0731_1 as follows (refer to Fig. 4-8): 
• In the tab „General“ as Mode, select „Input/Output“ („Settings“ block). 
• As Tag, select P0731_1 („Process“ block). 
• As Text list, select P0731 („Display“ block). 
 

 
Figure 4-8 Configuring the I/O field for variable P0731_1 
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Configure the I/O field for variable P1001_1 as follows (refer to Fig. 4-9): 
• In the tab „General“ as Mode, select „Input/Output“ („Settings“ block). 
• As Tag, select P1001_1 („Process“ block). 
• As Format type, select Decimal and as Format pattern, 99,99 („Display“ 

block). 
 

 
Figure 4-9 Configuring the I/O field for variable P1001_1 

 
 
Configure the I/O field for variable P0810_2 as follows (refer to Fig. 4-10): 
• In the tab „General“ as Mode, select „Input/Output“ („Settings“ block). 
• As Tag, select P0810_2 („Process“ block). 
• As Text list, select P0810 („Display“ block). 
 

 
Figure 4-10 Configuring the I/O field for variable P0810_2 
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Configure the I/O field for variable P0731_2 as follows (refer to Fig. 4-11): 
• In the tab „General“ as Mode, select „Input/Output“ („Settings“ block). 
• As Tag, select P0731_2 („Process“ block). 
• As Text list, select P0731 („Display“ block). 
 

 
Figure 4-11 Configuring the I/O field for variable P0731_2  

 
 
Configure the I/O field for variable P1001_2 as follows (refer to Fig. 4-9): 
• In the tab „General“ as Mode, select „Input/Output“ („Settings“ block). 
• As Tag, select P1001_2 („Process“ block). 
• As Format type, select Decimal and as Format pattern, 99,99 („Display“ 

block). 
 

 
Figure 4-12 Configuring the I/O field for variable P1001_2 
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Setting-up and configuring the button to exit the project presently running 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact"). 
 

Saving the WinCC project  
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.5 
"Configuring in WinCC Flexible Compact"). 
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4.6 PROFINET settings of the HMI device 

Switch on the power supply for the HMI device. The Loader opens once the 
operating system has started (refer to Fig. 4-13). 
 

  
Figure 4-13 Loader 

 
Press "Control Panel" to open the HMI device Control Panel (refer to Fig. 4-13). 
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Open the „PROFINET“ dialog with the „PROFINET“ 

 icon (refer to Fig. 4-14). 
 

 
Figure 4-14 Enable PROFINET IO 

 
• Activate the "PROFINET IO enabled" check box. 
• Enter a name for the HMI device in the „Device name“ input field (for example 

„TP177B“). 

• Close the dialog with  to save your entries. 
 

Open the "Transfer Settings" dialog with the "Transfer"  icon (refer to 
Fig. 4-15). 
 
Proceed as follows (refer to Fig. 4-15): 
• Activate the respective data channel with the "Enable Channel" check box in 

the "Channel 1" or "Channel 2" group (in the example „Channel 2“). 
• Configure the automatic transfer for the data channel 2. 

Check the "Remote Control" check box to turn on the automatic transfer. 
• As protocol, enter „ETHERNET“ for „Channel 2“. 

Touch the selection field. A selection list is displayed. 
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Figure 4-15 „Transfer Settings“ dialog 

 
• Press the "Advanced" button (refer to Fig. 4-15). 
 

 
Figure 4-16 „Network Configuration“ dialog 

 
• Touch "SMSC100FD1: Onboard LAN Ethernet Driver" 
• Touch the "Properties" button (refer to Fig. 4-16). 

The "Onboard LAN Ethernet Driver" dialog is displayed. 
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• Select the manual address assignment „Specify an IP address“. 
• Enter a PROFINET address for the HMI device in the „IP Address“ input field 

(in the example „192.168.0.45“). 
• Enter the subnet mask „255.255.255.0“ in the „Subnet Mask“ input field. 
 

 
Figure 4-17 "Onboard LAN Ethernet Driver" dialog, "IP Address" register 

 

• Close the dialogs „Onboard LAN Ethernet Driver“, „Network 
Configuration“ and „Transfer Settings“ with  to save your entries. 

 

Result: 
The PROFINET settings for the HMI device have now been set. 
 

Close the Control Panel of the HMI device with . The loader is displayed. Press 
the „Transfer“ button to start the „Transfer“ operating mode (refer to Fig. 3-34). 
 
The transfer operation must now be started from WinCC. 
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4.7 Transfer project in the HMI device 

In the WinCC menu, select „Project -> Transfer -> Transfer Settings…“ (refer to 
Fig. 3-35). 
 
The „Select devices for transfer“ window opens. Here, as Mode, select 
„Ethernet“ and set the PROFINET address of the operator control device (in our 
particular example this is „192.168.0.45“). Then press the „Transfer“ button (refer 
to Fig. 4-18). 
 

 
Figure 4-18 Selecting devices for transfer 

 
Acknowledge the message - „Do you want to overwrite the existing password 
list on the device?“ with „Yes“ (refer to Fig. 3-37). 
 

Result:  
The transfer operation is started. After the project has been successfully 
transferred into the operator control device, the project is started at the operator 
control device. 
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4.8  Controlling the drives 

Normal Operation: Control from the S7 control (PLC) 
Refer to the Section of the PROFIBUS example with the same name (Chapter 3.8 
"Controlling the frequency inverter"). 

Emergency Operation: Control from the HMI operator control device 
In „Emergency Operation“ the frequency inverters are controlled from the HMI 
operator control device.  
Proceed as follows (refer to Fig. 4-19): 
• For one of the frequency inverters, select "Emergency Operation": In the pull 

down menu for parameter P0810, select „1: Emergency Operation“. 
• Enter a setpoint for one of the frequency inverters by pressing the I/O field for 

P1001. The numerical keypad is displayed. 
• Power-up the frequency inverter by selecting „1: ON“ in the pull down menu 

for P0731.1. 
• Power-down the frequency inverter by selecting „0: OFF“ in the pull down 

menu for P0731.1 . 
• The project that is presently running can be exited by pressing the „Exit“ 

button. 

 
Figure 4-19 Controlling the frequency inverter from the HMI operator control device 
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Appendix and references 

5 References 
5.1 Internet link data 

This list is in no way complete and only reflects a selection of suitable references. 
 
Table 5-1 

 Subject area Title 

\1\ Manual TP 177A, TP 177B, OP 177B (WinCC flexible) 
\2\ Manuals MICROMASTER 4 

\3\ Manual MICROMASTER PROFIBUS Optional Board 

\4\ Manuals SINAMICS G120 

\5\ Manuals SINAMICS G120D 

\6\ Application note SINAMICS G: Reading from and writing to 
parameters of the Control Units CU240S/D 
PN/PN-F of the SINAMICS G120/G120D via 
PROFINET & PROFIBUS 

\7\ Application note ET 200S FC: Application sample for diagnosis 
and set up of ET200S FC via Touchpanel 
TP170B 

   

 

5.2 History 
 
Table 5-2 History 

Version Date Change 

V1.0 16.09.2005 First edition 
V2.0 July 2008 Revised, a detailed description for PROFIBUS DP and 

the PROFINET control has been generated, a project 
examples have been generated 

V2.1 Sept. 2009 ID-number reviesed 
V2.2 Jan. 2010 Exclusion of CU230 
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